NEMZETI SZAKKEPZESI
ES FELNOTTKEPZESI INTEZET

A kovetelménymodul megnevezése:

Kommunikacids és azzal kapcsolatos gazdasagi és informatikai tevékenységek

A kovetelménymodul szama: 0950-06 A tartalomelem azonosité szama és célcsoportja: SzT-013-55

/.—h_

U; Wegyarzrszy







WEBDESIGN

WEBDESIGN

Behaloztak benniinket... Az internet tetszik, vagy sem, benyomul az életiinkbe,
nélkilézhetetlenné teszi magat, akar levelezni, akar hireket olvasni, tajékozodni, filmeket
nézni vagy uram bocsd’, jatszani akarunk. Internetre van kotve a szamitégépiink, a
telefonunk, a radionk, tévénk, lassan mar a hiitészekrényiink is.

Emlékeznek a ,Halézat csapdajaban” cimd filmre? A film elejefelé, egy elegans tengerparton,
csodaszép bikinis lanyok és joképl pasasok kozott igy szél a f6hdés: , Hat ez szornyd. Itt
Glok a vildg legszebb Gduléhelyén, és bosszankodok, mert nincs hova dugni a modemet...”

ESETFELVETES—MUNKAHELYZET

On sikeres és ismert Ujsagiré. Munkdja sordn egyre nagyobb sziikségét érzi a korszeri
technika alkalmazasanak, noha mindezidadig idegenkedett téle. Baratai és kollégai mar
valamennyien sajat weoldallal, blogokkal, forumokkal biiszkélkednek, On pedig egyel6re
elképzelhetetlennek tartja, hogy valaha sajat weboldala legyen.

Most elhatdrozta, hogy valtoztat ezen a helyzeten, és megprébalkozik egy webes
megjelenéssel...

TANULASIRANYITO

A kovetkez6kben leirtak nem poétoljdk, és nem is pébtolhatjdk a szamitastechnikai
szakkonyveket, és kiilonésen nem az adott hardver vagy szoftver mdszaki leirdsat, kezelési
Utmutatdit, karbantartasi utasitasait. Ezért javasoljuk, hogy a leirtakat megértve, az azokban
foglaltakat sajat szamitogépes munkadllomasunkon lehetéség szerint probaljuk ki, valamint
igyekezziink a sajat berendezésiinkkel kapcsolatban minden olyan informaciot beszerezni,
amely a hatékony munkavégzést segiti.

A tovabbiakban leirtak elsajatitdsa komoly aktivitast igényel Ontdl.

Akkor tud eredményesen tanulni, ha sorban halad a tananyagban, s a tananyag szerves
részének tekinti a feladatokat. Tehat Ugy tanulja e tananyagot, hogy sorban halad; a
szlikséges feladatokat megoldja, majd levonja a tananyaghoz tartoz6 kovetkeztetéseket! Ezt
koévetben olvassa el tobbszor az elméleti részét a tananyagnak!

A tananyag elsajatitdsdhoz sziikséges tovabbi aktivitasok:
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- Olvasott szoveg feladattal vezetett feldolgozasa,
e olvasott szakmai szoveget kell megértenie,
e rendszerekben kell gondolkodnia,
e az olvasott szakmai szbveget a benne |évé feladatokhoz vezeté utként értelmezve,
problémaelemzésre, és problémafeltarasra van sziikség.

SZAKMAI INFORMACIOTARTALOM

1. Egy kis torténelem

A szamitastechnika vilaga annyiban hasonlit a focihoz, hogy mindenki azt hiszi, ért hozza.
Ezért azutdn szamos tévedés, nagyvarosi legenda forog kdzszajon - ezuttal az internettel
kapcsolatban kiséreljik meg néhany fogalom tisztazasat.

Elsé tévedés: Az Internet kialakulasa

Altalanosan elterjedt, miszerint az Internet azért jott volna létre, hogy az amerikai hadsereg
szamitégépes hdlozata tuléljen egy atomhabort.

Nos, nem lehettek az ARPANET' (az Internet 6se) megalkotéi ilyen naivak. Mar akkoriban
bizonyos volt, hogy egy atomhaborut nem lehet tulélni. Sokkal aktualisabb feladat volt egy
olyan hdl6zat megteremtése, amellyel az adatok gyorsabban és biztosabban eljuttathatéak
az egyik géprél a masikra, még akkor is, ha a koztik lévé kapcsolat megsériil. Ennek
hardver-feltételét az egyre jobb mindségl és egyre olcsdbb szamitdgépek, szoftverfeltételét
a csomagkapcsolt lizemmoéd, illetve a TCP/IP2 teremtette meg. Korabban ugyanis egy
nagyteljesitmény(i, kozponti szamitégéphez (nevezzik szervernek) kapcsolédtak
csillagszeriien a kiilonféle katonai objektumokba telepitett, lényegesen butabb gépek, vagyis
terminalok. Tehat mindenki a kozponti gép eréforrasait hasznalta. Ha valami baj tortént vele,
ledllt az egész. Az ARPANET tobbé-kevésbé egyenrangl gépek halézata, tehat mindenki lat
mindenkit, raadasul ha egy gép kiesik, a tobbi at tudja venni a funkciéjat.

A katonai halézatbdl Ugy valt Internet, vagyis vilaghaldé, hogy elkezdtek polgari szerverek is
kapcsolédni a mar meglévé maghoz. Sokkal kénnyebb volt példaul egy északon lévé
egyetemnek egy tdobbszaz kilométerre délen lévé konyvtarral Ugy kapcsolatot létesitenie,
hogy mindkét intézmény a helyi katonai szerverig épiti ki a kapcsolatot, onnan meg mar
csak gyorsabb...

Nyilvanvald, hogy a gyorsasdg mellett mar ekkor alapvetéen fontossa valt az adatbiztonsag
kérdése: Amit meg akarok tudni, azt gyorsan és biztosan megtudjam, viszont amihez semmi
kézom, ahhoz semmiképpen ne férjek hozza. Belathatd, hogy minden olyan intézkedés,
amelyik a biztonsagot fokozza, utjdban all az adataramlasnak, tehat lassit, és megforditva.

! Advanced Research Projects Agency Network
2 Transmission Control Protocol/Internet Protocol
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Ezen alapszik a masodik tévedés.

Masodik tévedés: Az Interneten van biztonsdgos hely

Nincs. Egyes adatok szerint a Internetes szerverek 80-85%-at mar feltorték valamilyen
modon, tobbek kézott a CIA, a Pentagon, az FBI is dldozatul esett - pedig ezekrél a cégekrél
igazdn nem mondhato, hogy amatérok lennének az adatbiztonsag teriiletén.

Hasonlé a helyzet, mint a gépkocsilopasok esetében: a legbiztosabb maddszer, -hogy ne
lopjak el az ember autéjat, ha eladja.

Barmilyen titkositas ugyanis, amit egy ember kitalal, azt egy masik ember meg tudja fejteni.
Becslések szerint egy-egy érdekesebb szervert naponta 100-150 hacker prébal feltorni -
nem csoda hat, hogy idénként valakinek sikeriil is.

Ez az, amirdl az atlagembernek fogalma sincs: aki még a Worddel is nehezen birkézik, el
sem tudja képzelni, mi is az, hogy feltorni...

Innen ered a -
Harmadik tévedés: A hacker kivételes tehetségli, szamitogépes zseni.

Pedig sz6 sincs kivételes tehetségrél. A szamitdstechnika megtanulhaté, a gépek
kiismerhet6ek, semmi mdgia nincs benniik - megfelel6 tudas birtokdban nem nehezebb egy
tavoli szamitégépet a megfelel6 FTP parancsokkal vezérelni, mint mondjuk, kuplungtarcsat
cserélni egy autéban. Persze, aki garantaltan egy szoget sem tud tisztességesen beverni,
illetve egy batch programot sem tud megirni, annak mindkét mdvelet lehetetlen.

A hackerekroél

Kik is azok a hackerek, akikrdél annyit hallani? A hackerek tarsadalma ugyanugy rétegzett,
mint barmelyik szakmaé, tagjai kiilonféle dolgokra specializalodtak.

Legfeliil, legkevesebben vannak a valédi hackerek (White-hat hacker, sneaker). Ok tényleg
piszkosul értenek a gépekhez, beldlik kerilnek ki a rendszergazdak, rendszerszervezék -
és az 6 fizetésiik tényleg a csillagos éghez igazodik. Eppen ezért 6k a legritkabb esetben
kovetnek el blincselekményt - tisztaban vannak azzal, hogy az Internet biztonsaga
mindennél fontosabb. Hiszen ha meginog a multik bizalma a vilaghaléban, azzal kézvetve a
sajat megélhetési forrasaikat veszélyeztetik!

Ok azok, akik éjjel-nappal keresik a biztonsagi rendszer hibait, réseit a megbizast adé
cégeknél, és ha be tudnak hatolni, azonnal intézkednek az adott hiba elharitasarél.
Tevékenységiikben azonban nincs semmi csodalatos, legfeljebb szaktudasuk elismerésre
mélto.
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Sokkal nagyobb a light-hackerek tabora. Ezek nagysdgrendekkel kisebb jovedelembdl élé,
rendszerint informatikat hallgaté egyetemistdk, akik egyrészt abbeli igyekezetiikben, hogy
az elébbi csoportba keriiljenek, masrészt erejik-tudasuk fitogtatasa céljabol kotorasznak az
Interneten. Gyakorlatilag semmiféle hasznosat nem csindlnak (hacsak azt nem szamitjuk,
hogy a hard-hackerek figyelmét rairanyitjdk bizonyos biztonsagi problémakra, résekre),
tevékenységik kimeriil abban, hogy feltornek egyes webhelyeket, illetve mindenféle
ostobasagot kiraknak az adott cég honlapjara. Néhany egyetemista példaul azzal valt hiressé
az Egyesiilt Allamokban, hogy az FBI honlapjat cserélték ki egy pornograf lapra.

A Black-hat hacker (dark-hacker, evil) blin6zé. Nyereség- vagy bosszuvagybol végzi
tevékenységét, kémkedik, illetve masok altal fizetett hitelrontasbol él. O csapolja meg az On
bankszamlajat, & teszi kozzé az On cégének adatait, 6 késziti az internetes virusokat, ¢
formazza le a tavolbdl az On winchesterét.

Kulén  tarsasagot képeznek a phreak-ek. A phreakek a telefonkézpontok
vezérlGszamitdégépeinek, a tavkozlési vonalak ingyenes igénybevételének és altaldaban a
telekommunikacionak a szakértéi. Rendelkeznek a kodzpontok atprogramozasahoz
szlkséges tudassal, illetve megfelel6 eszkozokkel a mobiltelefon haldézat forgalmanak, belsé
adatainak lehallgatdsahoz. Késébb 6k maguk, vagy akiknek az informacidkat tovabbadtak,
masok koltségére telefonalnak. Egyes adatok szerint az §sszesitett kar tobb mint 4 milliard
UsD.

A wannabe-hacker - mint a neve is mutatja - nem valodi hacker, csak szeretne az lenni.
Képtelen arra, hogy o©ndll6 programokat irjon, ezért a masok altal kitaldlt hack-
programokkal, exploitokkal dolgozik (ezekbdl, hdla a lightoknak, béven talalni az
Interneten). Ok hasznaljak a jelszéfeltéor6 programokat, az Ugynevezett Brute Force
maébdszert.

A legfiatalabb réteget a trollok (kb.: gonosz mandk) alkotjak. A troll minimalis szaktudas
birtokaban, gyakorlatilag céltalanul boklaszik és tesz tonkre mindent a Neten. Hasonlit
abban a wannabe-hoz, hogy 6 is kész programokkal dolgozik, azonban az elébbiekkel
ellentétben rendszerint fogalma sincs arrél, hogy mit csinal. A trollrél a személyi
szamitoégépek héskora (Spectrum, Commodore) jut az ember eszébe: mikor az anyukak
azzal dicsekszenek egymasnak a fodrasznal, hogy a kicsi micsoda egy szamitégépes zseni,
pedig valdojaban mind6ssze arrél van szo6, hogy a lurké egész nap szornyeket 16v6ldoz a
joystickkal.

A drifter viszonylag a legartalmatlanabb figura. O csak keres valamit, megtaldlja (esetleg
éppen az On gépén), lemasolja maganak és tovabball. Tevékenysége rendszerint észrevétlen
marad, legfeljebb a modem latszélag minden ok nélkil villogé TRANSMIT LED-je utal
jelenlétére.

llyen és ilyesfajta figurak tamadasainak lesz azonnal kitéve, ha weblapot készit...
De ne csiiggedjink. Egyrészt, weboldalunkat célszerlien valamilyen komoly szolgdltaté altal
nyudjtott helyen helyezzik el, a védekezés az 6 dolga lesz, neklink elég a sajat gépinket
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védeni, masrészt, vélhetéen jelenleg nem vagyunk kivanatos célpontok a hackerek szamara -
feltéve, ha nem milliardos nagysagrendl szamlakat kezel6 cégtulajdonosok vagyunk (ez
esetben valdszinlileg jol megfizetnénk valakit vagy valakiket, akik a védelemrél
gondoskodnak).

Miért kell ilyen témakkal foglalkoznia még annak is, aki egyfajta szent borzadallyal tekint a
szamitégépre?

Nos, az internet a Homo sapiens egyik legnagyobb és legbékésebb taldlmanya. Minden
feltétel adott ahhoz, hogy életiink sokkal kényelmesebb legyen: ha nem kell kilométereket
autézni a munkahelyre vagy az iskoldba, ha nem kell tomegben, szornylséges
bevasarlokocsikat egyensulyozni a pénztarnal, ha nem kell barmilyen hivatalos papirért
orakig sorba allni, mig végre odajut az ember a goromba ligyintézéhoz, ha nem kell kisebb
vagyonokat fizetni a telefonért, postaért, ha a vildg barmelyik Gjsagja, radidja, tévéje egy
kattintdsra bejon, ha a Suzukihoz sziikséges alkatrészt egyenesen Japanbdl lehet
megrendelni, sokkal olcsébban, kihagyva a kozvetité kereskeddket, alighanem jobb vilag
lesz.

Es akkor még nem széltunk a teljes vilagirodalomrél, amely el6bb-utébb barmely nyelven
hozzaférhet6, a maganyos emberekrél, akik az interneten baratokra lelnek, a koézelhozott
tavoli tdjakrél, ahova a valésagban soha nem juthatunk el, stb.

A szamitogépes kaldz, a virusok mindezeket a vivmanyokat kockaztatjdk. Hiszen mar attdl is
féliink, hogy az Interneten vasaroljunk...

Az emberiség mar tulélt néhany komolyabb jarvanyt - pestis, Ebola, AIDS stb. - most az
Interneten van a sor, hogy tulélje sajat virusait. Reményre ad okot, hogy, mint a fentiekbdl

kiderult, akik igazan értenek hozza, azokkal nincs gond.

A tobbieket meg majd kibirjuk valahogy.

2. Kezdeti lépések
A domainnév

El6szor is, ,adjunk nevet a gyereknek”.

DOMAINNEV

A tartomanynév (angolosan domainnév, illetve doménnév) egy szamitégép egyedi neve az
interneten, amely megkiilonbozteti a tobbitél. A tartomanynevek csupan cimkék melyeket a
nehezen megjegyezhetd IP-cimek helyett hasznalhatunk.

A tartomanyneveket gyakran 6sszekeverik a weblapokkal, webhelyekkel, a webcimekkel vagy
az internetes szolgaltatasokkal, melyek az adott néven (pontosabban az adott névvel
elérhetdé szamitogépen) érhetdek el. A tartomanyneveknek nincs szoros kdze a neveken
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elérhetd szolgaltatasokhoz (mint ahogy a hdazszamoknak sincs példaul kéziik ahhoz, hogy a
hazban pékség vagy nyomda lizemel).

Taldljunk hat ki valamilyen jol hangzé nevet a weboldalunknak - nem baj, ha a név a
weboldal tartalmdra utal, de nem is kotelezé. Legyiink otletesek, és féleg, lgyeljink arra,
hogy a név ne tartalmazzon lehetéleg ékezetes karaktereket - mert az internet nyelve, ki
tudja miért, hagyomanyosan nem a magyar... igy, barmilyen csabité példaul a lopétok.hu
domain, az interneten legfeljebb lopotok.hu lesz beléle.

A név kitalalasara recept nincs, azonban érdemes jol megfontolni ezt a Ipést, mert késébb
mar roppant macerds ezen valtoztatni. Gondoljuk végig, hogy mi a céliink a weblappal? Sajat
cégiinket, valamilyen szolgaltatast, esetleg egy terméket akarunk kozhirré tenni, esetleg
sajat, privat weboldalunkat szeretnénk felépiteni, csaladi fotdéinkkal, hobbinkkal, érdeklédési
koriunkkel?

Ha ez megvan, gyorsan ellenérizziik, hogy a név nem jutott-e eszébe mar masnak is. irjuk
be az adott domaint a bongészbbe, és, ha kapunk valailyen eredményt, akkor nyugodtan
bosszankodjunk - majd keressiink masik nevet.

Figyelem! Attél, hogy egy domain-t nem talal meg a béngészd, attél az még nem biztos,
hogy szabad. Az ellen6rzés kovetkezd Iépése, hogy valamiylen domain-szolgaltaté
weblapjat megnyitva, részletesen ellendrizziik, hogy az adott név szabad-e. Javaslat:
nézziink koril a domain.lap.hu oldalon, itt mindent megtalalunk a kezdeti lépésekhez.

Dontsiik el egyuttal azt is, hogy mi legyen a domain-neviink legfelsé szintje (TLD3): .hu,
.com, esetleg .eu vagy .info, vagy mas? Tudomdsul kell venni, hogy a magyar, illetve
magyaritott boéngészék -a .hu végzodést automatikusan hozza tudjak adni a beirt
domainnevekhez, a kiilfoldiek legfeljebb a .com-ot.

Vagyis, ha domainnévnek a mikkamakka.hu-t valasztjuk, akkor a magyaritott bongészék a
sima ,mikkamakka” beirassal is megtalalnak benniinket, ha mikkamakka.com, akkor
gyakorlatilag barmilyen bongész6 megteszi ugyanezt. Nyilvan, a kényelemért fizetni kell, a
.com végz6dés altaldban dragabb.

Ha szikség van ra, szamos hazai szolgaltatonal megtalaljuk a létezé valamennyi TLD-t,
tehat, ha kedvink tartja és pénziink is van ra, akar a Kékusz-szigetek (.cc) vagy az
Antarktisz (.tf) domainnevét is hasznalhatjuk.

1. feladat

Taldljunk ki egy jol hangzé domainnevet, és ellenérizziik, hogy szabad-e.
Melyik szolgaltaté weboldalan végeztik el az ellen6rzést?

* Top Level Domain
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2. feladat

Keressiik meg, hogy milyen orszaghoz tartoznak a kovetkezé TLD-k:

.ao0:

.bi:

.CX:

dj:

.eC:

fm:

gw:

. ht:

Jm:

kh:

Webtarhely

A kovetkezé6 |épés az lesz, hogy biztositunk maguknak egy megfelel6 méretl tarhelyet a
weben.

Hogy ez meg mi a csuda?

Gondoljuk el, hogy a weblapunknak allandéan, a nap 24 érajaban elérhetének kell lennie,
akar tobbszaz ember szamadra is. Hacsak mi maguk nem rendelkeziink valamilyen allandé és
brutdlisan gyors internetkapcsolattal, illetve egy olyan szamitégéppel, amelynek meg sem
kottyan a folyamatos lizem (az atlagos szamitogép néhany napig folyamatosan lizemeltetve
tulmelegszik, ledll, esetleg végleg tonkre is megy), bombabiztos az operaciés rendszere
(nem fagy le ,csak ugy”), és kell6képpen fel van vértezve a virusok, hackerek és egyéb
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baratsdgosnak nem nevezhetd lények tamadasai ellen - nos, akkor bérelniink kell egy ilyet.
No, nem az egész gépet, mindOdssze taroldjdnak egy részét, ahova sajat adatainkat
pakolhatjuk fel.

A mivelet hasonlit a lakasbérléshez, vigan élhetiink bérelt otthonunkban, amig a lakbért
fizetjuk a tulajdonosnak - a tatarozas és hasonlok nem a mi gondunk, sét, ha valami nem
tetszik, bontjuk a szerz6dést, és odébballunk.

A tarhely szolgdltatéjanak kivalasztasa fontos kérdés. Ha egy cég a fentebb leirt
szamitdgépekkel rendelkezik, és azokat bérbe adja, akkor ehhez kiilonféle feltételeket és
arakat is szab. Legyiink résen, olvassunk el az ajanlatban minden kis apré kiegészitést, mert
egyaltalan nem biztos, hogy a legolcsébb wbtarhely-ajanlatot tévé cég egyuttal a legjobb
valasztas is.

Altalaban a legjobban akkor jarunk, ha tn. akciés csomagokat valasztunk - ebben benne van

a domain-név regisztracidja, néhany e-mail cim, és a sziikséges tarhely is - évi néhany ezer
forintb6l meguszhatjuk az egészet.

3. A weboldal elkészitése

3. feladat

Keressiink a weben nekiink tetsz6 oldalakat! Melyek azoka grafikai elemek, amelyek
figyelmiinket megragadtak?

Mielétt a webszerkesztésnek nekifognank, tisztdzzuk magunkban, hogy mennyi munkat
vagyunk hajlandéak weboldalunkba befektetni.

Minimalis szint

Ha nem akarunk érakig vacakolni képekkel és egyebekkel, aranylag konnyen is készithetiink
weboldalakat.

Léteznek ugyanis weboldal-generalé szoftverek, ezekkel tényleg néhany kattintassal, és
egy-két adat megadasaval viszonylag tisztességes weboldal allithaté 6ssze - mindossze
annyi a probléma, mint a legtobb ,készen kapott”, ,el6regyartott” stb. anyaggal: sajat
kreativitasunkat guzsba kotjiuk, masok altal csinalt sablonokat, mintakat kell hasznalnunk,
és barki, aki csak kicsit is ért a weboldalakhoz, azonnal lesziri a véleményt rélunk, és ez
nem lesz tul hizelgé rank nézve.

Ne déljiink be a kiilonféle weboldal-generalé szoftverekkel kapcsolatos hirdetéseknek:

,készitse el bamulatos kinézet(i és tartalmu, lenylig6zé weboldalat egy éra alatt, mindenféle
el6zetes ismeret nélkil!” Az ilyesmit csak akkor higgyiik el, ha mar megvettiik a legljabb
Uzemanyag-adalékot, amely 50%-kal csokkenti a gépkocsi fogyasztasat, illetve
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megrendeltiik azt a fiatalité arckrémet, amelynek hasznalataval 20 évet letagadhatunk a
korunkbél...

Nyilvan els6é weblapjaink meglehet6sen csunyacskak lesznek, nem is biztos, hogy mikddni
fognak, és szinte mar banjuk, hogy nem egy ,tiz perc alatt kénnyen, gyorsan a webre”
stilusu sablonnal dolgoztunk. Azonban, ha szép lassan rajoviink az izére, észrevessziik,
hogy a leggyengébb, de midltalunk készitett és nem sablonos weboldal is 1ényegesen jobb,
mint a tomegben kinalt webvarazslék barmelyike.

Professzionalis szint

A komoly webprogramozék természetesen nem sablonokat hasznalnak. Ok kozvetleniil, a
megfelel6 nyelven irjak azokat a programokat, amelyek a bongész6t az altalunk
megfigyelheté latvany felrajzolasdra utasitjdk, olyan varazsigékkel ~kommunikalnak
egymassal, mint PHP, Java, Silverlight, Perl stb.

Természetesen ez nem a midltalunk valasztandé ut.
Felhasznaldi szint

Nos, ez all az esetfelvetésben leirtakhoz a legkozelebb. Tételezziik fel, hogy bizonyos
alapvetd szoftverismeretekkel mar rendelkeziink, és nem joviink zavarba, ha egy komolyabb
levelet meg kell irni, illetve, ha a csaladi fotobdl ki kell vagni Janos bacsit, aki ,belelog” a
képbe.

llyenkor magunk taldljuk ki-az elkészitendé oldal grafikai elemeit, szinvilagat és persze,
tartalmat is.

3.1. Milyen szoftverekre lesz sziikségiink?

A szoftverek kérdése izlés és pénztarca dolga. Ahogyan a szévegszerkeszt6 programok is
koriulbeul ugyanazt ,tudjak”, esetleg a szolgaltatasaik kozott vannak bizonyos extrak, gy a
webszerkesztés szoftverei is tobbé-kevésbé hasonléak - az extra funkciokat atlagos
felhasznalé amuigy sem fogja kihasznalni.

Kell tehat;

a. Weboldal-szerkeszt6 program (a példakban a Dreamweavert hasznaljuk, ez a
program az egyik legjobb - drdga ugyan, amde 30 napos, ingyenes prébaverzidjaval
mar elegendd idénk van sajat oldalunk elkészitésére). Létezik szdmos ingyenes,
alaszinten hasonld lehetéségeket nyujté program is, rovid keresés utan ezek
kénnyen megtalalhatéak.

b. Képszerkeszté program. Végsd esetben a Windows Paint-je is jo, valamint ilyenbdl is
szamtalan taldlhatd az interneten. A példaban egy masik ,nagyagyu”-t, a



WEBDESIGN

Photoshopot fogjuk hasznalni, amelynek szintigy van ingyenes, egy honapig
hasznalhaté prébaverzidja.

c. FTP program (FTP kliens). Ez arra jo, hogy az elkésziilt weboldalt tartalmazé fajlokat
feltoltsiik az el6bbiekben bérelt tarhelylinkre. Szamos ilyen létezik, mi az ingyenes
FTP Commandert hasznaljuk.

d. Web-bbdngészb, hogy meg is tudjuk nézni a weblapunkat. Javasoljuk a jél megszokott
Internet Explorert, nem mintha nem lenne nala jobb, hane, mert a Windows-vilagban
ezt hasznaljdk a legszélesebb korben, és ami ezen elfut, az altaldban minden egyéb
bongészdén is megy.

A fenti, a. és b. szoftvernek létezik magyaritott verzidja is, azonban jé, ha megszokjuk, hogy
bizony, az ineternet nyelve az angol. Raadasul, a tapasztalat szerint, angol nyelvi szoftverek
esetében kevésbé van késztetése az embernek ékezetes fajlneveket haszndlni - ami az
internetes oldalszerkesztésnél egyenld a biztos halallal.

3.2. Mibdl all egy internetes oldal?

Ha valakinek feltessziik a fenti kérdést, bizonyadra elkezdi sorolni, szovegek, képek,
mozgoképek, filmek, interaktiv mindenfélék, hangok stb. - pedig nem igy van. A weboldal
csak szovegbdl all. A képek, jatékok és egyebek ugy kerlilnek a weboldalra, hogy a
szovegben utasitasokat helyeziink el, amelyek a bongészét az adott tartalom betoltésére,
illetve megjelenitésére utasitja. Tehat a weboldal, ugy, ahogy latjuk, a valésagban nem
létezik, azt nekiink minden alkalommal a béngészé ,rakja 6ssze” a megfelel§ részekbdl.

A tovabbiakban mi csupan két dolgot fogunk elkésziteni: széveget (ami meg is jelenik) és
képeket (amitél latvanyosabb lesz az oldal).

A profi kinézetd, csillogo-villogé weboldalak altalaban Ggy jonnek létre, hogy egy masik
programocskat hiv be a bongészonk, és az altala krealt latvanyt illeszti be a weboldalba.
llyenek a kozkedvelt flash-animaciék, a java-programok, illetve a kilonféle online
médialejatszok is. Ezek mind kiilon szerkesztéprogramokat igényelnek, amelyekkel itt és
most nem fogalalkozunk.

Itt is meg kell emliteni, hogy ugyanigy, mint a hasonlé munkafiizetek esetében, jelen
munkaflizetnek nem lehet célja egy teljeskérd webdesign tanfolyam anyaganak
elsajatittatasa, mindossze egy kis betekintést tud nyujtani a weboldalak készitésének
rejtelmeibe.

A mi weboldalunk kizarélag HTML4 nyelvi utasitdsokat fog tartalmazni - ezeket minden
bongész6 azonnal megérti, és gyorsan el is tudja végezni.

HTML

A HTML (hiperszoveges jelolényelv) egy leird nyelv, melyet weboldalak készitéséhez
fejlesztettek ki, és mdara mar internetes szabvannya valt. A HTML-ben készitett allomanyok
tartalmazzak azokat a szimbdélumokat, elemeket, amelyek a megjelenité programnak leirjak,
hogyan is kell megjeleniteni illetve feldolgozni az adott allomany tartalmat.

* HyperText Markup Language
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3.3. Az oldal felépitése

Az egyszerlibb internetes oldalak felépitésében szem el6tt kell tartanunk a kovetkezdéket:

a. Nem tudhatjuk, hogy mekkora ablakban fognak benniinket bongészni. Az ablak
atméretezésével nem eshet szét az oldal.

b. A bdngész6k ablakaban a bal fels6 sarok az ,arkhimédészi fix pont”, vagyis az oldal
o0sszerakasa ettél a ponttél indul. A fontos részeket tehat ne jobbra és ne alulra
tegyuik.

c. Azt sem tudhatjuk, hogy mekkora monitorfelbontds mellett fognak benniinket
bongészni. Elvarhaté a 800x600-as méret, amde lehet ennek tdobbszorose is. A
tervezésnél figyeljiink, hogy kis és nagyméretben egyarant mutasson valamit az
oldal.

3.4. Az oldal szerkezete

Az internetes oldalak szerkezete nagyon sokféle lehet, az egyszer( tablazattél a roppant
bonyolult, animalt és interaktiv rendszerekig - mi a tovdbbiakban egy frame-es szerkezet(i
oldalt fogunk késziteni.

A frame a weboldalnak egy viszonylag 6nallé része, amely a tobbi frame-tél fiiggetleniil
szerkeszthetd. Esetiinkben ez annyit jelent, hogy a weboldalunkon harom frame lesz: egy a
fejlécnek, egy a meniiknek és egy nagy, a f6 tartalomnak. A késébbiekben akar bonyolultabb
frame-szerkezetekkel is megprébalkozhatunk.

| Teljes weboldal

Fejléc frame [

_~
_— Fo frame

Meni frame

A frame-szerkezet Oridsi elénye az, hogy az egyik frame-ben elhelyezett linket lehet Ugy
iranyitani, hogy a link altal megcimzett oldal egy masik frame-ben jelenjen meg. Emiatt
tudunk mentiket létrehozni a bal oldali frame-ben: az itt megcimzett oldalak, kattintasra, a
f6 frame ablakdban fognak megjelenni. A fejlécnek most minddssze annyi szerepet szanunk,
hogy a tobbi frame tartalmatél fliggetlenil mindig ott legyen az oldal tetején - igy ezt csak
egyszer kell megcsindlnunk.

3.5. Grafikai elemek

11
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Ennyi elméleti alapozas utdn nekifoghatunk a Photoshop-os munkanak. Javaslat: Minden
valtoztatast, grafikai elemet el6szor a PS-ban tervezziink meg és prébaljunk ki, lehetéleg
minden alkalommal (j réteget létrehozva. Ha igy jarunk el, és a teljes PS allomanyt
rendszeresen mentjiik, késébb, ha valamit valtoztatni akkarunk, nem kell el6rél kezdeni az
egész webszerkesztést.

Példankban tegyik fel, hogy orchideakedvel6k vagyunk, és létre akarunk hozni egy
orchiedakkal foglalkozé weboldalt.

Mar kivalasztottuk a domaint - legyen mondjuk orchidea.com -, el6fizettiink az egyok
szolgaltatd akciés csomagjdra, tehat miénk az orchidea.com domain és van egy 100 MB-os
tarhelylink is.

Photoshopos lépések: a hattér

Mielétt bdarmit csinalndnk (ha még nem tettilk volna meg), hozzunk létre valahol a
szamitégépiinkén egy mappat, amit kényelmesen elérhetiink, és tegyiink egy sllyos eskiit
magunknak: minden fajlt, amit a weblapunkhoz csindltunk, ide fogunk menteni (képeket,
szoveget, mindent!). Azt is fogadjuk meg, hogy a fajlnevekben még véletleniil sem irunk
nagybetiket, és féleg, ékezetes betiiket.

Komoly gondoknak vessziik elejét, ha esklinket be is tartjuk...

Vegyiik el6 a PS-t, és nyissunk egy 800x600-as lires lapot (lattuk, ez lehet a minimalis
méret. Az oldalt toltsik ki valamilyen orchidea=szinnel, pl. halvanylilaval, és egy Uj réteget
nyitva készitsiink a baloldalon és feliil egy sotétebb, L-alaku sdvot. Ez lesz a meni és a
fejléc helye.

Ha tgyesek vagyunk, legyen az L-alak ,honalja” egy kicsit lekerekitve.
A weblapok elemei legtobbszor tulsdgosan is szigoruan derékszogeket alkotnak, ennek

eltiintetése a korszerd tervezés egyik alapfeladata.

Ne ilyen legyen:

12
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inkabb ilyen:

Az L-alakot formazzuk ugy, hogy egy kis arnyékot is vessen, valamint legyen kissé

térhatasu, igy szebb lesz (Layers meni -> Blending options -> Drop shadow, és Bewel and
emboss)

Most itt tartunk:
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Ezutan keressiink valami kis képecskét a bal felsé sarokba - célszerlen egy orchideat -
ezutan egy nekiink tetszé betdtipussal készitsiik el a fejlécet:

Cﬁj{lz orchideak vilaga

£ g iF

Ezutan készitsiink el egy vezérlégombot. A gombnak két allapota lesz, kikapcsolt és
bekapcsolt. A példaban a széveg alatti kis sav fog majd ,vilagitani”, ha egérrel ramutat a
bongészd - hasznaljuk a fantaziankat, hogy mi valtozik a képecskén az egérmozdulatokra.

z orchideak vilaga

&£ 3 AP

bemutatkozds

Ne felejtsiik el, hogy mindent, amit lehet, kiilon rétegre tegytnk!
Ezek utan nekilathatunk feldarabolni a képiinket.
A PS képes arra, hogy segédvonalakat helyezziink el a képen, és a feldarabolast ezek mentén

végezziik el.

Hasznaljuk ki ezt a funkciot!

14
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Szikséglink lesz egy vagdsra pontosan a fejléc alatt (vigyazzunk, hogy az arnyék is benne
legyen!), a menisor mellett, tovabba a gomb koriil, valamint egy-egy kis szelet az L-alakbél

vizszintesen, illetve fliggblegesen.

T B 0 O I 0 TED S T A D e e ey et A Tk e
0—; .

3 ’Yn [ ] Ve L Vg
stz ofrchideak vilaga
0:
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0
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0
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E

0
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<

0

]

57

0

=

0

0

0o 9] Doc: 1,37M/5,45M DK

A kovetkez6 darabolast kell elvégezniink:

Bal fels6 grafikai elem, legyen a neve
wl.jpg

L orchideak vilaga

A fejléc masik része, neve legyen w2.jpg

A fejlév hatteréiil szolgdld darabka, w3.jpg

A meniiframe hattere, w4.jpg

A gombot is kivagjuk, de egyel6re nem jpg-ben, hanem psd-ben mentjiik el, mert itt még

bemutatkozds

minden rétegre sziikség lesz:
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A vezérl6gombok

Nyissuk is meg a gombot tartalmazo .psd fajlt. Most annyi gombot kell csinalnunk, ahany
meniipontot szeretnénk, raadasul mindbdl kettét - emlékezziinmk, kell egy inaktiv és egy
aktiv allapot.

Most minddssze hdrom menipontot készitiink: Bemutatkozas, Fajtak, Gondozas névvel. A
két-két jpg-t, amit elmentiink, ugy nevezzik el, hogy bele ne zavarodjunk. Példaul g-
bem1.jpg az inaktiv, g-bem?2.jpg az aktiv ,bemutatkozas” gomb. Ugyanigy g-fajl.jpg és g-
faj2.jpg, g-gond1.jpg és g-gond2. jpg.

Bemutatkozas bemutatkozds bemutathozds

Fajtak fojtak

Fn'iuln

Gondozas gondozds

ondom:

Ez egy darabig el fog tartani, fontos, hogy ne rontsuk el az elnevezéseket.
A weblap

Ha legyartottuk a kell6 mennyiségli grafikus elemet, nekildthatunk a weblap
megszerkesztésének. Vegyiik el6 a DreamWeavert és nyissunk egy tires HTML lapot:

@ ree fdn View dmet Moddy Format Commandi S Windos e | Bt B A~ otsiann = | [T

Weboldalunk HTML-
koédja
—]

Itt épiil a weboldalunk

Fontos menii:
a tulajdonsagok

I;...».;.M 0 —

Az oldalt osszuk fel frame-ekre: Insert -> HTML -> Frames -> left,

majd

Insert -> HTML -> Frames -> top.

Ha jél csinaltuk, most mar harom frame-ulnk van, amit a DW szépen el is nevezett topFrame,
leftFrame és mainFrame neveken. A left és top frame-eken hajtsunk végre egy kis mutétet:
Page properties —-> Appearance -> Left margin és Top margin legyen 0. Ez azért kell, hogy a
beszirt grafikai elemek pontosan a frame-ek széleihez illeszkedjenek.

16
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Ha ezzel megvagyunk, gyorsan mentsik el munkankat: File -> Save Frameset As. A névnek
irjuk be: index.html. Ugye, nem felejtettiik el a 3.5. bevezetésében irottakat...?!

JO, ha tudjuk: a webbongész6k minden megcimzett website-on ezt a fajlt fogjak keresni. Ha
a frameset-inket nem igy hivjak, hidba varjuk, hogy valaki ranktalaljon!

Ez még csak az oldal szerkezete, amit mentettiink. Még bele kell kattintani egyenként a
harom frame-be, és elmentegetni azokat is (Save Frame as), pl. menu.html, fej.html,
main.html néven. Ugye, még véletleniil sem irtunk ékezeteket...?

Most johetnek a képek. Kattintsunk a baloldali, menuframe-be, és Insert -> Image ->
wl.jpg.

A frame hatdrat pontosan a képhez kell igazitani, tehat kattintsunk a képre, olvassuk le,
hany pixel széles (jelen esetben 200), majd ragadjuk meg a frame hatarat és huzzuk
pontosan a kép széléhez. Kozben figyelhetjiik a HTML-kdédok ablakat: ha a <frameset
rows="*" cols="XXX,*" sorban az XXX értéke pontosan 200, akkor jél csinaltuk. Ha nem,
akkor siman irjuk at a cols értékét 200-ra, vigyazva, hogy mashoz ne nyuljunk.

Ugyanezt eljatsszuk a felsé frame-ben, itt a w2.jpg-t szlrjuk be, és a frame hatarat (rows) a
kép aljahoz igazitjuk. Példankban: <frameset rows="128,*" cols="*"

Most itt tartunk:

T

orchideak vilaga

bebts N 73 G oo - 831w 254 556/ se Lreeode LTEg)

43 hme Tarpeiedfule  <tirws (55 2ule > = Foot DefmitFot -B/EEAN @i

A frame-k hatterének valassziik ki az el6z6ekben elmentett kis darabkakat - fejlécnek a w3,
menusornak a w4-et (Page properties -> Appearance -> Background image.

A mainFrame hattere nem kép lesz, hanem ugyanaz a szin, amit a PS-ban beallitottunk.
Masoljuk at a PS-bodl az adott szin hatszamjegyl kédjat a Page properties -> Appearance ->
Background color-ba, példankban: e3b1df).

Most pont ugy néz ki a DW ablakban megjelené kép, mint a PS-ban volt, azzal a
kiulonbségggel, hogy ez mar egy miikod6képes weblap!
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Itt az ideje az ellen6rzésnek. Mnetsiink mindent (Save All), nyissuk meg azt a mappat,
amelyikhez az eskiink kot minket, és kattintsunk az index.html fajlra. A rendszeriink
alapértelmezett bongészGjében meg kell nyilnia elsé weboldalunknak! Ellenérizziik, hogy a
képek pontosan illeszkednek-e (vagyis nincs-e elcsliszas a framehatarok mentén).

Vezérlés

Sokat még nem lehet a weblapunkkal csindlni... Kévetkezzenek hat a vezérlégombok. Oket
kicsit masképp kell beszarni, mint a ,mezei’ képeket: Insert - > Image Objects -> Rollover
Image. A rollover image azt jelenti, hogy az adott kép egérmozdulatra atvaltozik egy masik
képre - pont erre van sziikségink.

A maniiframe-ben a sarok-kép ald rendre illesztgessilk be a harom vezérl6gombot,
mégpedig ugy, hogy ,original image’-nek mindig az 1-es, ,rollover image’-nek a 2-es jel(i
jpg fajlt valasztjuk ki.

Itt tartunk:

wodinnn e e s e B e e B v e e B 0 65

General
Browser specific
C5S/Accessibility
Language

Spry i

| »

s |[ASSERS | =]
| P Deskop ~ | Manage sites
Local Files | size[Typ
= Bl Desktop

M Szamitsgép
G- ¥ Halgzat
.. B FTP &RDS Servers
-7 Desktop items
<[ v

= @ ]
fajtak )

bemutatkozdrs

FRAMES

gondozds

<body> (W] G [100% +|631x 342+ 142K/ 21sec Unicode (UTF-3)

PROPERTIES | e mainFrame
<7 HIML Targeted Rule  body ~ | Font DefaultFont - B 7 @
| Bucss | Edit Rule €55 Panel Size Mone v D @

Page Properties...

Vegyik észre, hogy a késébbiekben az elmentett gomb-psd fajl felhasznalva, még sok-sok
tovabbi vezérl6gombot adhatunk a weblapunkhoz.

Hatra van még a rollover képekhez tarsitani a mainFrame-ben megjelené oldalakat - ez a
miuvelet a hiperlinkek lényege.

Tegyuk fel, hogy a késébbiekben létrehozandd bemutatkozé lap neve bemutat.html lesz, a
tovabbiak pedig fajtak.html és gondozas.html. Most el kell érniink, hogy a ,bemutatkozas”
gombra kattintva a mainFrame-ben megnyiljon a bemutat.html nevii lap.
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TeendG6ink: Katt a DW-ben a ,bemutatkozas” nevi rollover képen, majd a lenti Properties
ablakban a Link mezdébe be kell irni: bemutat.html. A Target mezdénél egyszerlen a
legordilé meniibdl valasszuk ki a mainFrame-t.

Es igy tovabb, vigydzzunk, a Target -> mainFrame Iépést ki ne hagyjuk, mert
o0sszekavarodik a lapunk.

Tovabbi oldalak

A meniiink mar tudjak, mit és hol kell megnyitni, csak a linkelt oldalak nem léteznek még.
Nyissunk hat egy 0j lapot a DW-ben, és gyorsan allitsuk is be a kivant hattérszint (Page
properties).

Ezutan irjunk sok-sok szoveget, amiben bemutatkozunk, rakjuk tele képekkel (Insert ->
Image) és mentsiik el bemutat.html néven.

Ugyanezt tegyilk meg a masik két oldallal is, b(ivoljik el a latogatot a szebbnél-szebb
orchidedk képeivel és osszuk meg a gondozdsukra vonatkozo6 tudnivalékat. Mentsik a
lapokat a megbeszélt neveken.

Miutan mindent mentettiink, Gjra nyissuk meg az index-html fajlt a bongészében, és
amuljunk-bamuljunk, milyen okosak vagyunk!

8 Untitied D urmerd - Wonhoet, iy e e (=i
Rt
Gll= e c ™i |4r ] x [ 29 coosie A~

| iz Kedvencek | 5 8 Webhelyajinit =

|| 48 Urttied Dociment Ti v B -0 v Oidel Bmtonsige Ezkosske e

-

gondozds
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Jegyzetek
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MEGOLDASOK

| 1. feladat

A feladat jellegébdl kovetkezden altalanos megoldas nem adhaté.
Példaul:

http://www.domain.hu/domain/domainsearch/
http://www.whois.net/
http://www.domainabc.hu/uj-regisztracio/

2. feladat

Keressiik meg, hogy milyen orszaghoz tartoznak a kovetkezé TLD-k:

.a0: Angola

.bi: Burundi

.CX: Karacsony-sziget

.dj: Dzsibuti

.ec: Ecuador

.fm: Mikronézia

.gw: Bissau-Guinea

. ht: Haiti

.id:_ Indonézia

Jm: Jamaica

.kh: Kambodzsa

3. feladat

A feladat jellegébdl kovetkezden altalanos megoldas nem adhato.
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IRODALOMJEGYZEK

Ajanlott irodalom:

e Vértes Janos(Szerk.): A szamitégéprél egyszerlien: PC sligd - Vertika Alkalmazas-
szolgaltaté Kft. Bp. 2009.

e Devecz Ferenc - Juhdsz Tibor - Kévés Rita - Reményi Zoltan - Siegler Gabor - Takacs
Barnabas: Irany az ecdl! - Nemzeti Tankonyvkiadé Zrt. 2009

e Bartfai Barnabas: Hogyan kezdjem? - a szamitégép kezelése kezd6knek - BBS-INFO
Konyvk. Es Inform. Kft. , 2008.

e Adobe Dreamweaver CS4 tanfolyam a kényvben. Perfact, Bp. 2010.

o Pétery Kristof: Adobe Photoshop CS4 Biblia., Mercator Bp. 2009.
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TAMOP 2.2.1 08/1-2008-0002 ,A képzés mindségének és tartalmanak
fejlesztése” keretében készilt.
A projekt az Eurdpai Unio tamogatasaval, az Eurdpai Szocialis Alap
tarsfinanszirozasaval valésul meg.

Kiadja a Nemzeti Szakképzési és Felnottképzési Intézet
1085 Budapest, Baross u. 52.
Telefon: (1) 210-1065, Fax: (1) 210-1063

FelelGs kiado:
Nagy Laszlé féigazgatd
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